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iFIX 6.0 New Features 

Long Tag Names and Descriptions 

With iFIX 6.0, tag names and description lengths increased from 30 characters to 256. This helps 
support longer tag names with complete hierarchies coming from the PLC. 

Please be aware of the following limitations when using this feature: 

• Older iFIX nodes cannot connect to iFIX 6.0 SCADA server. For example, you cannot connect a 
5.9 iClient to a 6.0 SCADA server.  However, a 6.0 iClient can still view a 5.9 or earlier SCADA 
server. 

• If using the Auto Alarm Manager (AAM), all the iFIX sender and receiver nodes (servers and 
clients) must be of same version. This is specific to iFIX 6.0 and above, as older iFIX nodes (iFIX 
5.9 and below) cannot connect to an iFIX 6.0 SCADA server. 

• When browsing tags in the Expression Editor on an iClient (view node), it may take 50% longer 
to perform the initial tag lookup. 

• When using with GE Historian 7 SP6 or earlier, you must limit iFIX tag names to 199 characters 
or less to support the Historian iFIX Collector and Historian Administrator interface. Using tags 
longer than 199 characters with Historian will result in an unstable system. 

• The maximum column length when you export an Enhanced Chart is 200 characters.  Be 
aware that when you take into account the node name and other characters that make up 
the tag such as the tag type (for example: .F_CV) the tag length maximum is probably closer to 
around 175 characters. 

• If using iFIX with Batch Execution, be aware that long tag names and descriptions are not 
support by Batch Execution. Batch Unit Definitions, Batch Phase Tag Definitions, and the Batch 
Watchdog Tag are all limited to 255 characters.  When using iFIX for these Items, the full 
Node:Tag:Field address must be used, so the length of your iFIX tag names should be 
considered when creating your iFIX database tags. 

• The Recipe Builder Reports limit the Tag Identifier to 100 Characters. 

• Tag Control Panel and Quick Trend screens are limited to tag names of 234 characters. 

• Microsoft Visual Basic limits character identifiers in scripts to a maximum of 255 characters.  

• The Discover and Auto Configure tool and the OPC Client Driver do not support long tag 
names or descriptions. 

• When using the iFIX Productivity Tools from Catapult, the Catapult dbArchitect tool will only 
support up to 255 characters for long tag names. 

For more information on configuring tags and descriptions in the Database Manager, refer to the iFIX 
Database Manager reference. 
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Alarm Shelving 

The Alarm Summary object in the iFIX WorkSpace already provides advanced alarm filtering and 
sorting capabilities for your alarm management needs, ensuring that your operators are viewing only 
the most important alarms on screen at any one time.  iFIX 6.0 now includes the extended capability to 
shelve alarms in the Alarm Summary object. With alarm shelving enabled, you can temporarily 
suppress selected alarms from the active alarms list in the Alarm Summary object for a fixed period of 
time.  

In addition to sorting and filtering, shelving helps improve the display of alarm information on screen 
and helps operators with prioritization so they can focus on only the highest priority alarms on screen 
at any point in time. Alarm shelving is particularly useful if there are lots of alarms for an operator to 
sort through. For example, if a piece of equipment or a portion of the plant is undergoing maintenance, 
it may be helpful to shelve some of the alarms originating from that equipment or part of the plant. 
Some of the alarms may be nuisance alarms while others may be of a lower priority since the 
equipment is in maintenance mode. Alarm shelving empowers your operators to make informed 
decisions, allowing operators to view and respond to only the pertinent alarms on their screens. 

Alarm Shelving in iFIX was built taking into consideration ISA 18.2 Shelving, giving you a thorough 
alarm management solution.  

Limitations 

• Alarm Shelving is not supported in the Auto Alarm Manager. 

How Alarm Shelving Works in the WorkSpace 

To view shelvable alarms from the Alarm Summary object in the iFIX WorkSpace, you need to add the 
new column to your alarm summary display. From the Alarm Summary Configuration, select the 
Column tab. Move the Shelvable and Shelve Duration (HHH:MM) columns to the Selected Columns list 
and click Apply. To view only shelved alarms in the Alarm Summary object, on the Filter tab, select 
Display only shelved alarms and click Apply.  

When in run mode, select the alarm or alarms you want to shelve from the Alarm Summary object, 
then with the alarms highlighted, use the right-click menu to access the pop-up menu and select the 
Shelve option.  Three shelve options are available: Custom duration, Maximum duration (limited to 999 
hours), or Preset duration. After you select the duration and click Shelve, the alarm (or alarms) 
temporarily gets removed from the alarm list. When the duration is expired, if the alarm is still active, it 
will pop back into the Alarm Summary list. 

To remove an alarm before a shelving period expires, right-click the selected the alarm or alarms and 
select Unshelve. This brings the alarm back in to the active alarm display. 

Be aware that the shelve durations are based off the system clock and not a timer. 

How to Configure Alarm Shelving in the Database Manager 

The following list of blocks support the Alarm Shelving feature. Shelving is enabled on the Alarms tab 
for the block. Shelve policy assignments also can be accessed from these blocks as well:  

• Analog Alarm (AA) 
• Analog Input (AI) 
• Digital Alarm (DA) 
• Digital Input (DI) 
• Multistate Digital Input (MDI) 
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• Program Block (PG) 
• PID or Proportional-Integral-Derivative (PID) 
• Statistical Data (SD) 
• SQL Trigger (SQT) 
• Timer (TM) 
• Text (TX) 

Additional Database Dynamos (loadable blocks added with Database Dynamo Configuration Utility, 
BTKCFG.exe) that support the Alarm Shelving feature include: 

• Analog Input with Freeform Scaling (AIS) 
• Transition Counter (CTR) 
• 16 Bit Digital Status (D16) 
• Improved PID (PI2) 

The shelving times are customizable. You can create alarm policies with different shelving times. 
Policies for alarm shelving time periods can be created in the Database Manager application.  On the 
Home tab, click the Shelve Policies button to access the Alarm Shelve Policies dialog box. Currently, 
you can define up to 20 shelving policies.  

For more information on Alarm Shelving, refer to the Implementing Alarms and Messages or iFIX 
Database Reference e-book. 

OPC UA Server 

The iFIX OPC UA Server implements OPC Unified Architecture (UA), which is a secure, scalable, multi-
platform communication protocol. The iFIX OPC UA Server allows OPC UA Clients to access data and 
alarms in the iFIX database.  

For example, you can use the OPC UA Server to share data in the iFIX Database with applications on 
your plant floor, with analytic tools, or with Enterprise Resource Planning (ERP) systems via OPC UA 
client interfaces. 

As an add-on component to iFIX, the iFIX OPC UA Server only runs when enabled, and when a valid 
certificate has been issued to the server (OPC UA applications need certificates to communicate if 
communication, privacy, and authentication are enabled). iFIX requires a restart after any change to 
OPC UA Server configuration. 

Configuration of the server includes enablement and identification, alarm setup, security options, 
certificate configuration (self-signed or through a Global Discover Server (GDS)), trust list management, 
and logging. 

Limitations of the OPC UA Server 

Limitations of the OPC UA Server include: 

• The OPC UA Server and the OPC UA Configuration tool is only supported on the SCADA Server. 
 Neither are supported on an iClient (View node) or Remote Desktop (Terminal Server) session. 

• The iFIX OPC UA Server is limited to processing approximately 2500 active tags in alarm at one 
time.  If this limit is exceeded, OPC UA clients may not see changes to the state of alarms. 

• The OPC UA Server is limited to two client connections. 
• The OPC UA Server provides data and alarms only from the SCADA Server on which it is 

running.  It does not provide access to data and alarms from other iFIX SCADAs. 
• The Enhanced Failover feature is not supported for iFIX OPC UA Server. The OPC UA server will 

provide data and alarms for the local SCADA only, regardless of its Active/Inactive failover 
state. 

• The Electronic Signature feature is not supported for OPC UA Server access. 
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• Web HMI 2.2 will not function with iFIX OPC UA for iFIX 6.0. Web HMI 2.2 still functions like it did 
with iFIX 5.9. A future release of Web HMI will support the iFIX OPC UA Server. 

• Historical OPC UA data sources are not supported. 
• OPC UA clients will not be able to perform alarm shelving; they will only be able to view the 

shelved state and changes to the state. 

Quick Start on How to Configure the OPC UA Server 

To configure the OPC UA Server in iFIX: 

1. From the ribbon bar on iFIX WorkSpace, select the Applications tab.  
2. Select OPC UA Configuration. The Server Configuration Tool appears.  
3. On the Server tab, select the Server Enabled option.  
4. Review the default settings for port, network address, logical host name, instance name and 

other associated application information. Make changes as needed. The network address 
must be the computer name or an IP address, as this represents how clients will locate the 
OPC UA server. It is suggested to use the iFIX SCADA node name as the Instance name, but 
not necessary.  

5. On the Certificate tab, select Generate Self-Signed.  
6. Optionally, on the Logging tab, review the logging settings. If the default level of logging is not 

detailed enough, you can change this value, but use caution in doing so! Using the highest 
levels of logging results in very verbose logging, and may impact performance and client 
connectivity. If you do select the highest level of logging, be sure to also enable the Optimize 
Log Output option to reduce disk access.  

7. Optionally, on the Security tab, review the security settings. 
8. Optionally, on the Alarms tab, select the Alarms Enabled option. Leave the defaults.  
9. Select Save and Exit to save all your changes.  
10. Restart iFIX. You must restart iFIX for your changes to take effect, as the OPC UA Server will 

start when iFIX starts.  
11. After iFIX starts, using the Windows Task Manager, confirm that iFixUaServer.exe is a running 

process. If it is not there, check the iFixUaServer.log file in LOCAL\Logs folder.  
12. Attempt to connect using an OPC UA Client with the server's URL. The first time you connect, a 

message appears asking you to trust the server certificate (depending upon the OPC UA client 
you are using, this message and how you trust the server can differ).  

13. Trust the server certificate.  
14. Try to connect the client again. The connection should be rejected with a 

BadSecurityChecksFailed error, because the server still needs to trust the client.  
15. On the iFIX Server, in the OPC UA Server Configuration Tool, click the Trust List tab.  
16. Select the client's certificate and then select Trust.  
17. Test the connection again.  

NOTE: The iFixUaServer.exe application does not need to be in the iFIX task list.  It runs with iFIX on 
startup automatically (and shuts itself down immediately if it is not enabled or if it does not have a self-
signed or GDS-signed certificate generated). 

For more information on an overview and configuration, refer to the OPC UA Server for iFIX e-book. 

Picture Publishing Capability for Web HMI 

The iFIX WorkSpace now includes a Picture Publish option for Web HMI on the Tools ribbon. This 
feature allows you to automate the picture export process.  Previously, the process required that you 
export pictures, and then associate them with asset types in the Web HMI model. Now, you can 
publish your iFIX pictures as mimics quickly in Web HMI, in less steps than with the Picture Export 
option.  
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Before you can use the Picture Publish option, you must set up your Web HMI configuration (server 
URL, port, user name, certificate, and mimic export path) in the iFIX WorkSpace so that the connection 
to Web HMI can be made. On the Home tab, select Tools > User Preferences, and then select Web HMI 
and enter your settings. After this is done, you can begin publishing pictures.  

For more information on picture publishing, refer to the Creating High Performance Pictures e-book. 

Domain Caching Support 

When iFIX Security is enabled, domain caching allows users to log in to iFIX even when they are not 
connected to a domain, such as in a corporate network. Only the logon information is persisted (not 
the full user name, for instance) to comply with Microsoft security policies. 

Domain caching is disabled by default in iFIX. To enable it, you need to update the SECNET.ini file in the 
iFIX/Local folder. Change the EnableDomainLogonCache setting from 0 to 1, like this: 

EnableDomainLogonCache=1 

Save the SECNET.ini file and restart iFIX.  

When using domain caching, be sure that other security countermeasures are enforced, such as 
strong passwords.  

In Microsoft Windows, if domain caching is enabled on the server for logins, be sure that you configure 
the Interactive logon: Number of previous logons to cache setting in the Windows security policies to 
something other than 0. For example, if the value is 5, the server caches logon information for 5 users. 
This security policy can be found in Computer Configuration > Windows Settings > Security Settings > 
Local Policies > Security Options.  

For more information on how domain caching works, refer to the Configuring Security Features e-
book. 

Support for Multiple Domains in the Security Synchronizer 

The Security Synchronizer is an iFIX application that allows you to assign iFIX security privileges to iFIX 
user accounts based on a Windows security configuration. This model enables you to use Windows 
security as a central source of configuration for both Windows and iFIX user accounts. In iFIX 6.0, the 
Security Synchronizer supports multiple domains. This means that iFIX also supports users from 
multiple domains.  

Be aware that when configuring your Windows users in iFIX Security, the Domain Name entry needs to 
be your domain's NetBIOS name. 

For more information on using the Security Synchronizer, refer to the Configuring Security Features e-
book. 

Support for Microsoft SQL Server 2017 

iFIX 6.0 added support for Microsoft SQL Server 2017. For full list of supported software, see the System 
Requirements. 
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Updates to FIXVBA 

The iFIX Automation References includes the following new property and methods for the Alarm 
Summary object to support the Alarm Shelving feature: 

• DisplayShelveAlarm Property 

• ShelveAlarm Method 

• UnShelveAlarm Method 

• GetSelectedRowAlarmInfo Method 

• GetSelectedRowsAlarmInfo Method 

For more information, refer to the iFIX Automation Reference e-book. 

Updates to iFIX Security 

When using iFIX Security, you can now save user passwords that are case-sensitive.  This was already 
possible when using Windows security along with iFIX.  You can now also do this without using 
Windows security. 

With iFIX Security, you are now limited to 3 failed login attempts.  

There are also new ways to access the login and logout options. In previous releases, you could only 
access the login from the Applications menu in the iFIX WorkSpace. In iFIX 6.0, additionally, you can 
access login or logout commands from the Options menu in the iFIX Startup window, or the quick 
access toolbar in the iFIX WorkSpace in run mode. 

For more information on iFIX security application features, refer to the Configuring Security Features e-
book. 

New Ribbon Icons  

iFIX 6.0 includes the following new icons on the application ribbons: 

• The iFIX Workspace includes and OPC UA Configuration icon on the Applications tab. 
• The Database Manager includes the Shelve Policies icon on the Home tab. 

New Security Application Features 

When using iFIX Security, you can lock down which application features are available to a specific 
group of users. To support the Alarm Shelving and OPC UA Server in iFIX 6.0, the following new security 
application features were added: 

• Alarm Shelving  

• OPC UA Configuration Tool 

When either of these features are applied to a group of users in the Security Configuration application, 
the user is allowed to access the feature. For Alarm Shelving, the user will be able to shelve an alarm in 
run mode.  If the Alarm Shelving feature is not enabled for a user, the user will not be able to shelve an 
alarm even if alarm shelving is enabled on that block. For the OPC UA Configuration Tool, without 
access to this feature, the user will not be able to access the configuration tool or save any 
configuration. 
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For more information on security application features, refer to the Understanding iFIX Security section 
of in the Configuring Security Features e-book. 

New Alarm Counter 

Alarm Counters provide a way for you to determine the general alarm state of a single SCADA server, 
or areas within that server. They indicate how many tags on a node are in alarm, how many of these 
alarms are CRITICAL, HIHI, HIGH, MEDIUM, LOW, LOLO, and INFO priority, and how many are 
acknowledged or unacknowledged. iFIX 6.0 includes the new Alarm Counter field, A_SHELVETOT, to 
display the number of currently shelved alarms.  

For more information on Alarm Counters, refer to the Implementing Alarms and Messages e-book. 

Updated Default Data Refresh Rate on All New Animations 

In iFIX 6.0, the default refresh rate for newly created animations is 1 second.  Previously, it was .1 
seconds. This change was implemented to help optimize performance on new pictures.  

For more information on specifying the refresh rates, refer to the Creating Pictures e-book. 

Support for Recently Updated GE Products 

iFIX 6.0 includes support for the following recently updated GE products: 

• Workflow and Task List 2.6 

• Web HMI 2.2 and 2.1. 

• WebSpace 5.0 

• Change Management 9.5 

• Latest Service Packs for Historian and Plant Applications  

For a complete list of products and versions tested to work with the iFIX 6.0 product, go to the System 
Requirements tab and scroll to the Compatibility with Other GE Products section. 

Updated Third-party Applications 

The following applications were updated to support the iFIX 6.0 release: 

• iFIX Productivity Tools from Catapult (included on the iFIX install media). Includes updates to 
support the latest version of iFIX. 

• Industrial Gateway Server (IGS) 7.63. Includes support for all the latest driver fixes.   

Revisions to the iFIX Toolkits (EDA, BTK, STK) 
All iFIX Toolkits, including the EDA (also known as the FITK), BTK, and STK toolkits, have been updated to 
support iFIX 6.0 and the changes for alarm shelving and long tag names and descriptions. If you plan 
on using applications built with older versions of the toolkits, you must upgrade your toolkit to the 
latest version of iFIX as well. You can perform an in-place upgrade for the BTK and STK toolkits. 
However, to upgrade your EDA (FITK) toolkit, you must uninstall it and then reinstall the latest version. 
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Be aware that after you upgrade, you must update and recompile your applications or block with the 
latest version of the toolkit. For example, any EDA toolkit based application must be recompiled 
against iFIX 6.0 in order to work with the new long tag name structures. Your toolkit version should 
match your iFIX version.  

New Licensing Options 
New with your iFIX license are two OPC UA Server connections. You can add up to eight more. This will 
also be made available for iFIX 5.9 licenses ordered and activated after November 1, 2018. It is only 
available for iFIX 5.9 and above. For iFIX 5.9 users, getting the OPC UA server will require downloading 
a SIM. Please visit our Customer Knowledge Portal for a list of all SIMs: https://digitalsupport.ge.com/ 

Updated Documentation 
This release also includes an updated IPI, Getting Started Guide, and new Help topics. 

All Functionality from 5.9 SIMs 

This release contains all iFIX 5.9 SIMs released through August 27, 2018. 

Workflow Trigger Re-Added to Install Media 

The Workflow Trigger product is included again on the iFIX install media. (It was removed in iFIX 5.9.) 
The install is also available on the support site, https://digitalsupport.ge.com to download. 

Items Removed from iFIX 6.0 

If you are upgrading from a previous version of iFIX, be aware that the following items have been 
removed from iFIX 6.0: 

• Classic Historian 

• FIX32 Migration Tools 

• Support for Microsoft Windows 2008 R2 

NOTE: If you need to support migration of FIX32 screens to iFIX 6.0, it is recommended that you 
upgrade them to an earlier version of iFIX (such as iFIX 5.5 or 5.9) and then open your screens in iFIX 
6.0. iFIX 5.5 did not include Enhanced Coordinates, whereas iFIX 5.9 did. If you do not want your 
pictures to be converted to use Enhanced Coordinates, then use iFIX 5.5 to convert your pictures. 

IMPORTANT: Be aware that updating to iFIX 6.0 (or later) from a previous version will remove Classic 
Historian binaries.  Before updating, make sure you have a plan to migrate your historical data to 
Historian Essentials or some other permanent storage. 

 

https://digitalsupport.ge.com/
https://digitalsupport.ge.com/
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Important Upgrade Information 
Please be aware of the following before you perform an upgrade from a previous version of iFIX: 

• Due to the database changes for long tag names and descriptions, older iFIX nodes cannot 
connect to an iFIX 6.0 SCADA server. For example, you cannot connect a 5.9 iClient to a 6.0 
iFIX SCADA server. Be sure to have a plan in place to upgrade any clients that need to access 
an iFIX 6.0 SCADA server.  

NOTE: An iFIX 6.0 iClient can still view a 5.9 or earlier SCADA server, however. 

• If using the Auto Alarm Manager (AAM), all the iFIX sender and receiver nodes (servers and 
clients) must be of same version. This is specific to iFIX 6.0 and above, as older iFIX nodes (iFIX 
5.9 and below) cannot connect to an iFIX 6.0 SCADA Server. 

• Before updating, make sure you have a plan to migrate your historical data to Historian 
Essentials or some other permanent storage.  

After an upgrade, be aware that: 

• When browsing tags in the Expression Editor on an iClient (View node), it may take 50% longer 
to perform the initial tag lookup. 

• Any toolkit that you use in addition to iFIX will require an update. It is recommended that you 
upgrade your toolkit to the latest version of iFIX, after you upgrade iFIX. Be aware that after 
you upgrade your toolkit, you must update and recompile your applications or block with the 
latest version of the toolkit. Your toolkit version should match your iFIX version. 

• After an upgrade, if you want to use iFIX with Microsoft Access you must perform a manual 
update to the Registry and an update of the Microsoft Access database in Design View. In the 
Windows Registry, make the following entries for the MaxLocksLimit key: REG_DWORD and 
0x00030d40 (200000). To find the MaxLocksLimit key, look to the Microsoft Office version-
specific Registry entry under HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft. In Microsoft 
Access, update the ALM_TAGNAME and ALM_TAGDESC (if it exists) rows to be formatted as a 
LONGTEXT (MEMO) fields.  

• If Classic Historian, HTC.exe, exists in the startup task list in the iFIX SCU, then you must 
manually remove HTC.exe from the startup task list after the upgrade to iFIX 6.0.  

iFIX 6.0 Release Notes 

If You Are a First-time User... 

Run in Demo Mode to Experiment with iFIX Projects First 

If this is your first time using the iFIX product, try using iFIX in Demo mode. In Demo mode, you can run 
iFIX applications for 2 hours. To start in Demo mode, start iFIX from command line using the 
parameter, like this: 

Launch.exe /t 
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Where to Go First for More Information 

Check out the Getting Started with iFIX guide first. The first few chapters of this guide contains detailed 
information about installing and upgrading iFIX, as well as supported configurations. 

For a general overview of iFIX and the WorkSpace, refer to the Understanding iFIX electronic book. 

For an overview of how to configure your iFIX system, refer to the Setting up the Environment 
electronic book. 

Licensing on Microsoft Common Controls Installed with iFIX 

iFIX installs Microsoft common controls as part of the iFIX installation. These controls are used 
internally by iFIX. You cannot use them directly unless you have installed a product that provides the 
license to these controls, such as Microsoft Visual C++ or Visual Basic or have an Microsoft Office 
product installed. Otherwise, you can download the appropriate distribution package from Microsoft's 
Knowledge Base. 

Installation 

Installing as an Administrator 

You must install iFIX with a local Windows user account with administrator rights. See your Windows 
manuals or online Help for information on creating this account. 

Installing iFIX 

Without an iFIX license, you can run iFIX applications for 2 hours in Demo mode.  

NOTE: When configured for WebSpace, none of the iFIX SCU’s on WebSpace Server should be 
configured to start iFIX as service, as this is a unsupported configuration.  

To install the product: 

1. Log in as a user with Administrator rights.  
2. Shut down any GE applications or services that run on startup. For instance, if you have 

Historian Collectors configured to start when you start Windows, use the Services window to 
shut them down.  

3. Follow the steps on your screen. For more detailed information on installing your iFIX product, 
see the "Installing the iFIX Software" section in the Getting Started with iFIX guide.  

4. After the install completes install your license. For more information on installing and 
configuring your license, refer to the GE Digital Support site: https://ge-
ip.force.com/communities/en_US/Article/GE-Intelligent-Platforms-Software-Product-
Licensing.  

5. Make sure that you restart your computer after you finish the install steps.  

TIP: If you get a message that a necessary Windows security update for the Universal C Runtime 
component is missing on this computer, be sure to install the Microsoft Update, KB2999226, and then 
try installing iFIX again. To install KB2999226, you may need to install other updates first. Refer to the 
Microsoft web site for details. If you get any other Windows error when you try to install iFIX, perform a 
Windows Update and then try to install iFIX again.   

https://ge-ip.force.com/communities/en_US/Article/GE-Intelligent-Platforms-Software-Product-Licensing
https://ge-ip.force.com/communities/en_US/Article/GE-Intelligent-Platforms-Software-Product-Licensing
https://ge-ip.force.com/communities/en_US/Article/GE-Intelligent-Platforms-Software-Product-Licensing
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IMPORTANT: Be aware that if you do not already have .NET 4.6.1 installed and you choose to install 
iFIX, the .NET 4.6.1 install will run first. After it installs, you will be prompted to restart your computer. 
After the restart, the iFIX install continues. The install media must be available or connected to the 
target machine the entire time for the install to finish. 

Installing iFIX with Terminal Services Enabled 

IMPORTANT: Be aware that all Terminal Server client users should be a member of the Remote 
Desktop Users group.  

Upgrade Notes 

Before You Upgrade or Reinstall... 

Before you upgrade the iFIX product installed on your computer, make sure you shut down all GE 
applications. It is important that no GE products are running when you run the iFIX installation 
program. 

NOTE: iFIX WebSpace must be uninstalled before/after the upgrade to iFIX 6.0. Instead of iFIX 
WebSpace, WebSpace 5.0 needs to be installed and configured to work with iFIX. 

IMPORTANT: If you are upgrading from a previous version of iFIX with failover enabled, and you 
want to use the Enhanced Failover feature in iFIX 5.0 or greater, there are a number of issues that 
you must be aware of. For detailed information and steps describing how to upgrade your failover 
system, see the Enhanced Failover and Upgrading" section on the New Features tab. 

Save copies of your existing .INI files with your application preferences and any custom files you 
create; customized files may be overwritten during an upgrade. As such, you may need to integrate 
your custom changes into the newer versions of these files after you upgrade.  

Back up your existing iFIX projects. This includes the files in your LOCAL, Config Files Backup, PIC, and 
PDB folders.  

It is also recommended that you create a backup copy of your Alarm ODBC configuration file(s). 

Export a report of your system configuration (SCU), for reference. (In the SCU, on the File menu, click 
Report.) 

Export a report of your security configuration, for reference. (In the Security Configuration application, 
on the File menu, click Export.) 

If you have an application created by an Integration Toolkit, Database Dynamo Toolkit, or System 
Extension Toolkit from iFIX 2.5 or earlier, and you want to use this application with iFIX 6.0, do not 
uninstall iFIX. You must install iFIX 6.0 over your existing iFIX configuration. Your toolkit application will 
not run if you uninstall your previous version of iFIX. 

Be sure to obtain any toolkit updates that you need, prior to installing iFIX.  

CAUTION: If you choose to integrate Historian with iFIX, make sure that your database tags have 
unique names. If both your iFIX and Historian databases have the same tag name, when you import an 
iFIX tag into the Historian database, the Historian tag will be overwritten with the tag of the same 
name from the iFIX database. For more information, see Using iFIX with Historian and Troubleshooting 
Historian and iFIX. 
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Upgrade Steps 

To upgrade to the latest version of iFIX, perform the following steps:  

1. Confirm that you backed up all the applicable files. Refer to the Before You Upgrade or 
Reinstall... section above for more details.  

2. Shut down any GE applications or Proficy services that are running. For instance, if you have 
Historian Collectors configured to start when you start Windows, use the Services window to 
shut them down.  

3. Run the iFIX product install. A message box appears asking you if you want to upgrade your 
system.  

4. Click Yes to continue.  
5. Follow the instructions on your screen.  

Standard Chart Upgrade Notes 

Be aware that after an upgrade, if you have Standard Charts with Classic Historian data for data 
sources, that you may need to modify these data sources after an upgrade. When configured for use 
by pens in the Standard Chart, single quotes in Classic Historian data sources are not stripped out 
after an upgrade. 

Pictures and the Upgrade 

Prior to iFIX 6.0, when you opened a picture from a previous version of iFIX in the newer version, and 
saved it, your picture was automatically updated to the newest version of iFIX. Pictures created with 
iFIX 5.5 (or earlier) were created with a Logical Coordinate System, which uses logical units for screen 
measurements. The Logical Coordinate System allowed this automatic upgrading.  

With iFIX 6.0, pictures are not automatically upgraded because this version uses the Enhanced 
Coordinate System for screen measurements. An expert is provided to easily upgrade pictures you 
select from the legacy Logical Coordinate System to the new Enhanced Coordinate System.  

You can use both the Logical and Enhanced Coordinate Systems with iFIX. For example, you can edit a 
legacy picture before you upgrade it. By default, the Enhanced Coordinate System is enabled for new 
picture creation. For more information on this expert and on coordinate systems, refer to the Creating 
Pictures e-book  

NOTE: Be aware that pictures with Enhanced Charts containing tag groups will display a message 
on upgrade. However, pictures with Historical datalinks and Historical animations with tag groups 
will not. 

Due to the design of the VisiconX objects in iFIX 5.0 and greater, it is recommended that you manually 
replace your older VisiconX objects with the newer versions (if you are upgrading from a version of iFIX 
prior to iFIX 5.0).  

The Database and the Upgrade 

Be aware that when you upgrade to iFIX 6.0, the file size of your process database file will increase.  

When you upgrade your database, the high and low engineering units (EGU) fields are converted from 
single precision to double precision floats. This means the degree of accuracy (the Epsilon value) 
changes from +/_0.00000012 to +/_0.00000000000000022. If you are using extreme ranges (very 
large or very low values) for your EGU limits, you may possibly experience issues after an upgrade. To 
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resolve these issues, open the Database Manager, export your database and then re-import it. This 
procedure resets the block values. 

DDA Drivers and the Upgrade 

If you are using DDA drivers, such as ROC, BR3 or MBR, you must reinstall them after upgrade. If the 
driver installation files are unavailable, you can use a copy of your existing FIX.INI file to compare to 
the one created after the upgrade. Then, copy the missing lines from your old FIX.INI file to your new 
FIX.INI file. 

Custom *.fxg Files and the Upgrade 

Be aware that if you use custom .fxg files with iFIX and you choose to upgrade, you will need to re-
register these .fxg files after the iFIX upgrade. For more information on how to re-register the 
WorkSpace, refer to the "Adding Files to the System Tree" topic in the Mastering iFIX e-book.  

Restoring the Settings in the iFIX .INI Files 

As you install iFIX, the product install program places a new version of the startup control file, FIX.INI, 
into your iFIX Local folder. The previous version of this file is copied to the Config Files Backup folder, 
along with the other configuration files. 

If you configured Database Dynamos, also known as loadable blocks, or other custom programs to run 
as part of iFIX startup, you should compare the new FIX.INI file in the Local folder against the FIX.INI file 
stored in the Config Files Backup folder. If you find any changes between the two files, add the 
necessary lines to the FIX.INI stored in the Local path. 

Additionally, you should restore other .INI files as necessary, using the same process. 

Upgrading Database Dynamos 

Database Dynamos, also known as loadable blocks, will require updates to work with iFIX 6.0. If you 
have old Database Dynamos on your system, the iFIX install program will detect them, and generate a 
warning message.  

The GE Digital web site contains updated versions of the Database Dynamos supplied by GE Digital. To 
obtain updated version of other dynamos, contact the vendor of that dynamo. To obtain the current 
version of the Database Dynamo Toolkit, contact your local iFIX sales representative. 

Upgrading Application Toolkit files 

If you have an application created by an Integration Toolkit, Database Dynamo Toolkit, or System 
Extension Toolkit, and you want to use this application with iFIX 6.0, do not uninstall iFIX. You must 
install iFIX 6.0 over your existing iFIX configuration. After installing iFIX, rebuild your existing 
applications with the newest toolkit available to ensure compatibility with iFIX 6.0.  
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Important Information for Windows Users 

Accessing Remote OPC Servers in Windows 

Before you can access remote OPC servers in iFIX, such as through the Discovery and Auto-Assembly 
Component (DAC) and the OPC Client driver, you must make sure that your firewall settings are correct, 
and that the DCOM settings for your operating system are correct. For detailed steps on how to do this, 
refer to the "Setting up for Remote OPC Server Access" chapter in the Getting Started with iFIX book. 

Disabling Fast Startup in Microsoft Windows 8.1 

In Windows 8.1, there is a functionality available in the Power Options called “Fast startup” (Power 
Options are accessible from the Settings > Control Panel).  When “Fast startup” is enabled as a Power 
Option (the default) and you power down your computer or tablet, Windows will save the current state 
of the system. The next time you restart Windows, your previous state is restored. This is because, by 
default, Microsoft Windows 8 and 8.1 shuts down by logging off all users and then hibernating.  In this 
case, any service that was running will continue to run on the next startup.  

When iFIX is running as a service, you may want to avoid this "Fast Startup" functionality. To revert to 
the full shutdown on Windows 8.1, in the Power Options on the SCADA Server, select "Choose what the 
power buttons do." Select the “Change settings that are currently unavailable” option and then scroll 
down to the Shutdown Settings area, and clear the “Turn on Fast startup” option. 

(The "Fast Startup" feature is not available on Microsoft Windows Server 2012.) 

Troubleshooting iFIX Product Issues After the Install 

My-T-Soft Window Display Issues 

If you install the My-T-Soft on screen keyboard for use with iFIX and experience window display issues, 
such as the Minimize button being hidden off-screen, you can use the MYTSOFT.ini file to adjust the 
settings of the application. 

For example, when you have the WorkSpace in Ribbon view (the default), the caption bar with the 
Minimize icon is displayed off screen. It's there, but you cannot view it. >My-T-Soft allows you to 
customize where the Minimize button positions itself through the MYTSOFT.ini file located in the iFIX 
install folder. By changing the ButtonOffsetY=0 setting to a positive number, you can move the button 
down a specified number of pixels, allowing the Minimize button and caption bar to show in full screen, 
when in ribbon view. After this value is configured, the My-T-Soft keyboard will always display in that 
specified offset position. 

iFIX Does Not Start After an Upgrade 

Be aware that when you install iFIX over an existing version, the security privileges for the iFIX folder 
may allow Read and Execute permissions only. Limited permissions can cause various problems, such 
as the inability to open the STARTUP.LOG file or to write to the Alarm Area Database files.  

To change the security permissions on this folder, follow these steps: 

1. Open Windows Explorer by clicking the Start button, and pointing to Programs, Accessories, 
and then Windows Explorer.  
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2. Locate the folder to which you installed iFIX. (For example:  C:\Program Files 
(x86)\Proficy\Proficy iFIX.  

3. Right-click the iFIX folder and select Properties from the right-click menu. The Properties 
dialog box appears.  

4. Click the Security tab.  
5. Select the Users group in the top half of the dialog box.  
6. Select the Allow check box for the Modify, Read & Execute, List Folder Contents, Read, and 

Write permissions in the bottom half of the dialog box.  
7. Click OK.  

Unsupported Items and Recommendations 

Enhanced Failover and Legacy Clients  

IMPORTANT: In an Enhanced Failover pair, both SCADA nodes must have the same iFIX version 
installed with all SIMs.  

Microsoft Office Document References in the iFIX WorkSpace System Tree 

You can no longer open new Microsoft Office documents (such as Microsoft® Excel or Word 2013 or 
2016) inside the iFIX WorkSpace.  These documents will now launch separate in the associated 
Microsoft application, outside of the WorkSpace. 

If you want to archive these Microsoft applications along with your project with Backup and Restore or 
Change Management, the Excel and Word documents must be saved to "App" sub-folder in the 
WorkSpace system tree. 

Ribbon View and Unsupported Microsoft Windows Themes 

High Contrast themes are not supported when running the iFIX WorkSpace in Ribbon view. 

iFIX Screen Saver and Microsoft® Windows® 8.1, 10, and Microsoft® Windows® 
Server 2012 and 2016 

The iFIX Screen Saver is not supported on Microsoft® Windows® 8.1, 10 and Microsoft® Windows® 
Server 2012 and 2016. 

UNC Paths and Install 

Installing the product from UNC paths is not supported or recommended. 

Running SCADA Nodes on Wireless Devices 

It is strongly recommended that you do not run SCADA nodes on wireless devices. Running an iFIX 
SCADA on a wireless device may impact performance, as most available wireless protocols fall below 
the recommended bandwidth requirements. 

Intel® Itanium® Processor  

The Intel® Itanium® Processor is not supported for iFIX on 64-bit operating systems.  
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Alarm Viewer 

The Alarm Viewer is no longer installed as part of iFIX. If you are upgrading from a previous version of 
iFIX, your pictures with Alarm Viewer objects will continue to work. At the time of this release, however, 
the Alarm Viewer is not supported on a Windows 64-bit enabled operating system.  

Migration Tools are Removed from iFIX 6.0 

Migration tools are not supported from iFIX 6.0 , if ODF files exist then user must use older versions of 
iFIX to upgrade screens. 

FIX Desktop 

iFIX no longer supports FIX Desktop.  

Classic Historian 

As of 6.0, iFIX no longer supports Classic Historian and it has been removed from the program. 
Updating to iFIX 6.0 (or later) from a previous version will remove the Classic Historian binaries. Before 
updating, make sure you have a plan to migrate your historical data to Historian Essentials, or some 
other permanent storage.  

Migration Tools 

iFIX 6.0 does not support the FIX32 migration tools. If an .ODF files exists, that you want to convert, you 
must use an older version of iFIX to upgrade screens first before opening the picture in iFIX 6.0.  

Historian 4.5 and Earlier 

Historian 4.5 and earlier are not supported.  

Historian for SCADA 

Historian for SCADA version 4.5, 5.0, 5.5 are not supported with iFIX 6.0.  Users with Historian for SCADA 
4.5, 5.0, 5.5 will be required to upgrade to Historian Essentials. 

Speedstep Technology   

SpeedStep® technology is not supported and must not be enabled. 

IPv6 

FIX does not make use of any IPv6 functionality.   

If you disable IPv6 to use WebSpace, make sure that your local HOSTS file does not contain any IPv6 
references. For example, remove the "::1 localhost" lines from the HOSTS file, and replace them a line 
that references the IP address and the local host name (if necessary). 
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Unsupported Windows Operating Systems 

The following are no longer a supported operating system for iFIX: 

• Microsoft Windows Server 2008 R2 

• Microsoft Windows 2003 

• Microsoft Windows XP 

• Microsoft Windows XP Embedded 

• Microsoft Windows 2000 

• Microsoft Windows NT 

• Microsoft Windows Vista 

Drivers and Operating System Compatibility 

Be sure to check with the vendor of your driver software to confirm that your driver supports the 
operating system you want to run it on. 

DAC and Operating System Compatibility 

Be sure to check with the vendor of your driver software to confirm that your driver supports the 
operating system you want to run it on. If your driver is not supported on the specified operating 
system, you may experience issues with the Discover and Auto Configure (DAC) tool since it interfaces 
with the driver.  

OPC and Running as a Service and on Some Operating Systems 

If you want to run the OPC Client driver as a service, iFIX must also run as a service. Likewise, if you 
want to run iFIX as a service, the OPC Client driver must run as a service. You cannot run one as a 
service, without the other also running as a service.  

If you want to run the OPC Client driver on a specified operating system, be sure to check with the 
vendor of your OPC Server software to confirm that your OPC Server supports the operating system 
you want to run it on.  

It is recommended that you install the latest OPC Core Components from the Downloads section of the 
OPC Foundation web site: http://www.opcfoundation.org. The latest OPC Core components are 
designed for use on a 64-bit OS.  

Backwards Portability of Alarm ODBC Configuration 

Once you open or create an Alarm ODBC configuration file in iFIX 6.0, you cannot open that file on a 
node running iFIX 2.6 or earlier. Opening the file on a node running iFIX 2.6 or earlier will cause 
unpredictable results. It is recommended that you create a backup copy of your Alarm ODBC 
configuration file before installing the latest iFIX version. 

Backwards Portability of Process Databases 

To ensure a secure signing environment, GE Digital strongly discourages editing an iFIX 6.0 process 
database on an older-version node. If you open a 6.0 database on an older-version node, such as 2.6, 
you cannot add or modify individual tags, although it is possible to modify the database, such as to 
delete and duplicate tags. Do not do this. 
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Backwards Compatibility of 5.9 Pictures 

The iFIX 6.0 pictures are not backwards compatible in earlier versions of iFIX, such as iFIX 5.9, 5.8, 5.5, 
5.1, 5.0, 4.5, 4.0, 3.5, 3.0, or 2.5. If you try to open an iFIX 6.0 picture in an earlier version of the iFIX 
WorkSpace, an error message appears stating that you need to upgrade your software to the newer 
release, and the file does not load. If you use multiple versions of iFIX, store your pictures locally or use 
a separate shared pictures path for each version of iFIX.  

OPC Servers that Require an Access Path 

The iFIX WorkSpace does not support OPC servers that require an Access Path, such as RSLinx. To use 
an OPC Server like RSLinx with iFIX, configure the server so that it does not require a value for the 
access path. In order to do this with RSLinx, use the following syntax: [topic]item.  

Mission Control's Datascope Screen with 7.x Drivers 

The Datascope screen in Mission Control does not work with version 7.x drivers. If you select a version 
7.x driver in Mission Control, you cannot use the Datascope button. 

Using the Virtual Keyboard to Enter Large Amounts of Data 

The virtual keyboard is designed for password and data entry. Avoid using this virtual keyboard for 
entering large amounts of text in Windows, as unexpected behavior may result. Certain combinations 
of keystrokes may cause the virtual keyboard to display incorrect characters. The virtual keyboard 
should behave as expected if you restrict its use to entering passwords and other data entry. 

Using iFIX Objects in Other Applications 

iFIX ships with several objects that are for internal use only. Please refrain from using these objects in 
external applications. Some examples of these objects are: 

• iFIX Alarm Summary Control  
• iFIX Color Button Control  
• iFIX Expression Editor Control  
• iFIX WorkSpace Expression Editor  

Modifying the ExpertGlobal.fxg or ExpertGlobals2.fxg  

It is strongly recommended that you do not modify ExpertGlobal.fxg or ExpertGlobals2.fxg. If you do 
modify either of these files, you may experience problems installing a subsequent SIM. If the modified 
ExpertGlobal.fxg or ExpertGlobals2.fxg file has a newer date than the one in the SIM, the SIM 
installation will fail. You will either need to remove the modified file or rename it to successfully install a 
SIM. 

Instead of modifying the file, you can copy any of the experts from this file and incorporate them into 
your own custom toolbar.  

Data Bound Controls 

Do not use Visual Basic Data Bound controls with iFIX. These controls are not supported by VBA. 
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Quit Method's SaveChanges Parameter 

The SaveChanges parameter for the Quit method is not supported at this time. Regardless of the 
parameter you enter, you are prompted whether or not you want the option to save changes. If you 
select Yes, you are prompted to switch to the Configure environment to save changes. If you select No, 
the WorkSpace closes without saving changes. 

Find and Replace Object Outside of the WorkSpace 

The Find and Replace object is not accessible from clients that reside in a process outside the 
WorkSpace. Any programs you create using Visual Basic will not support the Find and Replace feature. 

VisiconX and Large Databases 

Caution is advised when using VisiconX and large databases. VisiconX controls do not perform well 
with really large databases. 

Microsoft Windows Related Issues 

Updating Root Certificates 

If you are unable to run My-T-Soft, install the update for the root certificates. For more information and 
for the update, see Microsoft knowledge base article KB931125. 

Incorrect Icons Appear in Start Menu or Desktop Shortcuts 

Windows saves a cached copy of all icons. If the icon cache becomes corrupt, incorrect icons may 
appear.  

To fix this issue, display hidden files in Explorer, delete the icon cache file, and restart Windows. This 
action restores the icon cache. 

iFIX WorkSpace Related Issues 

WorkSpace Startup     

After starting the operating system, the first time the WorkSpace is started, you may notice that it 
takes longer for the WorkSpace to start up. Subsequent WorkSpace startups will not experience the 
delay. The delay is related to the number of pictures in the picture folder, so smaller projects may not 
experience the delay.  

Print to File Option Not Working Properly For Pictures or Schedules 

From the iFIX WorkSpace, when you open a picture or schedule and then click Print, the Print dialog 
box provides a "Print to File" option. If you select this check box, the file is not created. A dialog box 
does not appear requesting a file name. And, the file is sent to the printer, even though you selected 
the Print to File check box. There is no known workaround for this issue. 
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Changing the System Year to 2038 Causes Unpredictable Behavior 

If you change the system year to 2038, the iFIX WorkSpace may behave unpredictably and shutdown. 
This is a C programming language Y2K issue and is caused by the standard time library in C. There is 
no known workaround for this issue.  

Clicking the Calendar Control Shuts Down the WorkSpace 

If you double-click a calendar control in the iFIX WorkSpace configure mode, or if you single-click it in 
WorkSpace run mode, it may shut down the WorkSpace. The Microsoft Calendar control causes similar 
issues in other Microsoft Office products. This is a known Microsoft issue.  

A Picture or Dynamo Appears Distorted in Logical Coordinate System 

It is possible that when a picture or Dynamo set is created with the Logical Coordinate System at one 
resolution, it will appear distorted when viewed on a monitor with a different resolution. This may 
occur because the default display properties of Windows are causing the autoscale function of iFIX to 
function improperly, or are making a VBA form that prevents the picture or Dynamo from updating 
properly.  

To correct this problem: 

1. Open the Windows Control Panel.  
2. Click the Appearance and Personalization link.  
3. In the Personalization category, click the Customize Colors link.  
4. Click the "Open classic appearance properties for more color options" link. The Appearance 

Settings dialog box appears.  
5. Click the Effects button.  
6. Clear the Show window contents while dragging check box.  

NOTE: The TrueColor graphic display option also distorts some Dynamos. We recommend that you 
avoid using it. 

Guidelines for Using the iFIX Cross Reference Tool 

Avoid Missing References in your Pictures 

When you use the Cross Reference Tool Report Wizard to generate a report on a .GRF file that has a 
missing reference, an error message appears in the background, and the Cross Reference Tool report 
generation is halted. 

The report generation remains halted until you click on the Cross Reference Tool. This causes the 
following message to appear: "An action cannot be completed because a component (iFIX WorkSpace 
(Configure) is not responding. Choose "Switch To" to activate the component and correct the problem."  

Use the Switch To button and acknowledge the several dialog boxes that appear. To avoid this 
problem altogether, check for missing references before running the report wizard. 

Close All Dialog Boxes in the WorkSpace Before Running the Report Wizard 

If you try use the Cross Reference Tool Report Wizard when certain dialog boxes are open in the 
WorkSpace, such as the User Preferences or the Find and Replace dialog boxes, an error may occur.  
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For instance, the following message may display: "The Cross Reference application could not export 
VBA script files. Your ExpertGlobal may be corrupted. Cross Reference is exiting." 

Click OK to acknowledge this message and allow the Cross Reference application to exit. To prevent 
this message from occurring in the first place, close all dialog boxes in the WorkSpace before you run 
the Report Wizard in the Cross Reference Tool. 

 

Avoid Running the Report Wizard with Read-Only Files 

When you use the Cross Reference Tool Report Wizard to generate a report, the following message 
appears if one or more of the files is read-only: "An action cannot be completed because a component 
(iFIX WorkSpace (Configure)) is not responding. Choose "Switch To" to activate the component and 
correct the problem." 

When you switch to the WorkSpace, this error appears: "Error number -2147211306. The file you are 
attempting to open has been renamed outside the WorkSpace. Please make sure you have write 
access to the file and try again." 

Once you clear these messages, run the report again. Additionally, you can also use either of these 
techniques to resolve this issue: 

Remove the read-only attribute – Identify all files being searched for that have a read-only 
attribute. Remove the read-only attribute. 

Upgrade the file – Upgrade the file if you choose to leave the read-only attribute. To upgrade 
the file, remove the read-only attribute on the file, open the file in the WorkSpace 
configuration mode, and close the file. The file is automatically upgraded. You then have to 
add the read-only attribute to the file. 

Working with Other GE Products 

Using Historian with iFIX 

Security Considerations 

If security is enabled for Historian, and you do not have the necessary security group memberships, 
you will not be able to use Mission Control to start or stop Historian collectors. To give the iFIX 
WorkSpace and Mission Control access to the Historian collectors, configure a user name and 
password in one of the following Historian dialog boxes: 

• Configure the Historian Server(s) Access this dialog box by clicking Configure Historian Server 
on the Historian toolbar.  

• Historian Administrator Login Access this dialog box by opening the Historian Administrator 
and clicking Main.  

Be sure to read the Historian IPI (Important Product Information) document for tips about using the 
product in general. 

Please refer to the following KB article, article ID:15129, for authentication information for WebSpace 
and Historian: http://support.ge-ip.com/support/index?page=kbchannel&id=S:KB15129&actp=search  

 

http://support.ge-ip.com/support/index?page=kbchannel&id=S:KB15129&actp=search
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Regional Settings Considerations 

The iFIX Scheduler and charts can use Historian data that supports Daylight Savings Time. However, 
before allowing automatic Daylight Saving Time to be used in a production environment, you should 
test your application under each of the following scenarios for proper behavior: 

• While in Standard Time.  
• While in Daylight Time.  
• During the transition from Standard Time to Daylight Time.  
• During the transition from Daylight Time to Standard Time.  

Working with iFIX Drivers 

Using the PowerTool after Installing iFIX 

Each 7.x driver has a PowerTool. If you want to run the PowerTool configuration program of a 7.x driver 
without running iFIX, you must have an iFIX key installed. 

Starting 7.x Drivers Automatically in iFIX 

The startup list in the SCU typically has the /A command line parameter in the IOCNTRL.EXE program. 
The /A parameter is used to start all I/O drivers identified in the SCADA configuration of the SCU. 

Use the Advanced tab of the PowerTool dialog box to set the Auto Start for each driver. If you do not 
use the /A parameter and: 

• the Auto Start setting in the PowerTool is set to On, 7.x driver starts automatically.  
• the Auto Start setting in the PowerTool is set to Off, 7.x driver does not start automatically.  

Issues with Remote OPC Servers and the WorkSpace 

When remotely connected to some OPC servers, the iFIX WorkSpace does not shut down after exiting. 
You may experience this issue with the following drivers: 

• ABR  
• GE9  
• M32  
• MBE  
• OPC  
• SI5  
• SL4  
• SI7  

Refer to the GlobalCare web site for software downloads for I/O driver updates: 

https://digitalsupport.ge.com  

https://digitalsupport.ge.com/
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Using Third-Party Products with iFIX 

Upgrade Older Versions of Third-Party Controls  

Be aware that using an older version of some third-party controls, such as AMOVIE.OCX, may cause 
memory overwrites. These overwrites may in turn cause iFIX to perform unpredictably. To avoid 
problems with third-party controls, be sure to use the most recent version of all third-party controls. 

 

Use the MSFlexGrid Control Effectively 

If you use the MSFlexGrid control in an iFIX picture, you may encounter slow performance when you try 
to open or save your picture, or when you try to switch environments. To resolve this issue: 

1. Open a new picture.  
2. Drag and drop the MSFlexGrid control from the old picture into the new picture.  
3. Delete the MSFlexGrid control from the old picture.  
4. Save the old picture.  
5. Drag and drop the MSFlexGrid control back into the old picture and re-save it.  
6. Delete the new picture.  

Licensing Issues with MSFlexGrid Control 

When inserting an MSFlexGrid control into the WorkSpace, you may receive an error message 
indicating that you do not have a license to use this control. If this occurs, you need to either install 
Visual Basic on the computer where you are running WorkSpace, or add the licensing keys to the 
registry. 

For more information, refer to the Microsoft Knowledge Base article 318597. 

Register Third-Party OPC Data Sources Properly 

Certain third-party OPC servers do not support the ValidateItems call. If you try to connect to items in 
that third-party OPC server through the iFIX Animations dialog box, you will get an error for items that 
exist in your OPC server: "ItemName Source does not exist. Create or Use Anyway?" 

To eliminate this error, you need to make the following registry change for the OPC data source.  

1. Add the string value "ValidateItemsNotSupported" to 
\HKEY_CLASSES_ROOT\FIX32\DataSources\OPCSERVERNAME key.  

2. Set the string value to "true".  

For example, if your third-party OPC server is installed as SOMEOPCSERVER, then you would add the 
string value "ValidateItemsNotSupported" to 
\HKEY_CLASSES_ROOT\FIX32\DataSources\SOMEOPCSERVER key, setting the string value to "true." 
This change verifies that data items on OPC Servers not implementing the ValidateItems call can be 
read. 
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Optimizing iFIX Performance 

Activate Duplicated Tags by Reloading the Database 

When you duplicate a tag in Database Manager, the new tag will only return a value once, unless you 
save and reload your database. For example, if you have a link in a picture that monitors the current 
value of an AI tag connected to a SIM register, you can duplicate this tag, rename it, and add a link to 
the picture that monitors this new tag. However, after the first read, subsequent reads will not work 
until you save and reload the database. 

 

For More Tips on Optimizing iFIX...  

Look up "optimization, introduction" in the online help Index. This link brings you to an Introduction in 
the Optimizing Your iFIX System guide. This guide lists tips and strategies you can use while developing 
pictures, writing scripts, and implementing your iFIX system. 

iFIX VBA Tips and Tricks 

Visual Basic for Applications, or VBA, is the standard scripting language built into iFIX. VBA can be used 
to customize and extend the functionality of iFIX. Use these guidelines when creating applications in 
the Visual Basic Editor from iFIX: 

• Refrain from using punctuation marks, pound sign (#), and VBA reserved words within VBA file 
names.  

• Avoid generating a script within a script, that is currently executing. This causes unpredictable 
results.  

• Do not use the WM_CLOSE SendMessage to close a user form; the object does not get 
destroyed properly. If you must close a form with a script, use the WM_DESTROY 
SendMessage.  

• Avoid referencing the Intellution iFIX Find and Replace Mechanism v1.0 Type Library in your 
project. It causes an error when you compile your script.  

• Be aware that a script based on an object's event should not call the DestroyObject method 
on the parent of the same object. Doing so causes unpredictable results.  

• If you are using any of the iFIX subroutines to write data back to the database, use the F_CV 
field as the data link. Using the A_CV field may cause unpredictable results.  

• Do not use the DblClick event when you configure a Data link for "In-Place" data entry. If you 
do, the DblClick event does not execute.  

• Do not access class modules that are declared as PRIVATE in an out of process environment, 
such as user.fxg, expert globals, or any Global pages. This is not allowed.  

• Be aware that when you change a source tag in iFIX, an automation error displays if you do 
not allow iFIX enough time to establish the new connection before you read the InputValue 
property. The wait time depends on the scan time of the event object source tag.  

• If you set a tag with a static value as the source tag twice in a row, you will cause an 
automation error.  

For more information on using VBA in your iFIX projects, look up "summaries" or "scripting, in iFIX" in 
the online help Index. 



 

35 

Code Example: Checking for a Null Value with the iFIX RealTime ODBC Driver  

The iFIX RealTime ODBC driver was built to allow NULL values to be returned. For example, when 
checking iFIX real time data for a tag that does not exist, a value of NULL is returned when the tag is 
not found. In some instances, it may be helpful to check for the NULL value so that it is not counted as 
one string returned. The following is an example of code that will allow you to check for the NULL 
value: 

If Record.ID "" Then 
MSG = "A valid record exists" 
Else 
MSG = "A null situation exists" 
End If 
MsgBox MSG 

 

Code Example: Creating a VB Client Application Properly 

Creating a VB client application that accesses the WorkSpace.Application object through early binding 
causes unpredictable results. For example, the following sample script, which uses early binding, 
causes the WorkSpace to terminate unexpectedly: 

Private Sub Form_Load() 
Dim iApp As CFixApp 
Dim iSystem As Object 
Set iApp = CreateObject("WorkSpace.Application") 
Set iSystem = iApp.System 
End Sub 

To avoid this problem, replace the second line in the above sample script with the following line: 

Dim iApp As Object 

Uninstall and Reinstall Issues 

If iFIX is used by multiple users, and you uninstall and then reinstall it to a different folder, you may 
experience issues with some users. These user issues can also occur in other versions of iFIX.  

For example, say UserA installs iFIX to C:\LocationA, and then both UserA and UserB make use of iFIX. If 
UserA uninstalls iFIX and then reinstalls iFIX to another location, say D:\LocationB, without deleting 
C:\LocationA, UserB may experience issues. Although UserA will be able to use iFIX in its new location 
without any problems, UserB will see several error messages if he tries to launch iFIX or the SCU, since 
his registry paths still point to C:\LocationA. 

As a workaround, open the Windows Registry and delete the HKEY_USERS\<USER'S 
ID>\Software\Proficy\iFIX\ProjectPaths key which contains the old paths. For example, deleting the 
HKEY_USERS\S-1-5-21-3882306234-4042192530-3641380709-1028\Software\Proficy\Proficy 
iFIX\ProjectPaths key would alleviate this issue for a user with an ID of S-1-5-21-3882306234-
4042192530-3641380709-1028. After updating the Registry, be sure to restart iFIX.  

IMPORTANT Add/Remove Information for Historian 

If you choose to remove Historian from the Add or Remove Programs in the Control Panel, do not 
remove Microsoft system files if prompted to do so. This could cause critical operating system issues.  
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iFIX 6.0 Known Issues 
 
Defect # Area Description 

DE92547 Historian Integration iFIX Collector Fails When Browsing iFIX Tags in the Historian Administrator 
If you try to browse tags, for instance from the Add Multiple Tags from 
Collector dialog box in the Historian Administrator, the iFIX Collector will fail.  
Be aware that you can still add tags, up to 199 characters long, for collection 
using FixToHist.exe.  
 
This is a known issue with the Historian Collector in iFIX 6.0. Look for a 
Historian update to be released with a fix.  

DE91265 WorkSpace Bad WebHMI Server Name Entered Into User Preferences or Web HMI Publish 
Screen Causes WorkSpace to Be Unresponsive 
This is a known issue in iFIX 6.0 and only occurs if a you enter a bad server 
name. 

DE90938 Upgrade OPC UA Server Does Not Start 
If you have iFIX with Productivity Tools installed and you upgrade to iFIX 6.0, 
then the FIX.INI file does not contain an entry for the iFIX OPC UA Server. As a 
workaround, manually update the FIX.INI to include this entry at the end of 
the [SCADA] section: RUN=%IFIXUASERVER.EXE. Restart iFIX after you save 
your changes. 

DE90685 Mission Control HTC Tab is not Working With Historian Installed 
In iFIX 6.0, Historical Collector actions are no longer supported from the iFIX 
Mission control application, mission.exe. Please use the Historian 
Administrator UI instead. 

DE89991 Change 
Management 

Alarm Shelving Related Fields Are Not Shown in the Text Compare Report 
Alarm Shelving related fields are not shown in the Text Compare Report in the 
Change Management History window.  

DE84751 Alarm Shelving Alarm Shelving Status Incorrect When Alarms Are Sent Over AAM 
When using the Auto Alarm Manager (AAM) with Alarm Shelving, be aware 
that the Alarm Shelving Status is incorrect when alarms are sent via AAM. 

DE89722 Windows Security Change Password Button Disabled in the Login Dialog Box 
The Change Password button is disabled in the Login dialog box when using 
Windows Security with a local Windows account. 

DE87524 Upgrade Altered Table Failing for Microsoft Access Database Due to Long Tag Names 
and Descriptions 
After upgrading to iFIX 6.0, when using Microsoft Access to log Alarms using 
ODBC, an error occurs. To use iFIX after an upgrade with Microsoft Access 
requires a manual update to the Registry and an update of the Microsoft 
Access database in Design View. The ALM_TAGNAME and ALM_TAGDESC (if it 
exists) rows needs to be formatted as a LONGTEXT (MEMO) field.  
 
Use these steps: 
1. In the Windows Registry, make the following entries for the MaxLocksLimit 
key: REG_DWORD and 0x00030d40 (200000). To find the MaxLocksLimit key, 
look to the Microsoft Office version-specific Registry entry under 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft. 
2. Open Microsoft Access. 
3. In Microsoft Access, open the database previously configured for Alarm 
ODBC in iFIX prior to 6.0. 
4. Right-click the table and select Design View. 
5. Select the ALM_TAGNAME row, Data Type column, and then change Text to 
Memo. 
6. Repeat the previous step with the ALM_TAGDESC row, if it exists in the 
table. 
7. Save the Access database. 
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Defect # Area Description 

US244795 VisiconX VisiconX Returns Oracle Error 
When using VisiconX, be aware that you must configure your environment 
variables correctly for Oracle. If you select the Microsoft OLE DB Provider for 
ODBC Drivers as your data source, when you try to select an Oracle table, you 
will experience an error. On the Oracle Client machine where iFIX is installed, 
set the ORACLE_HOME environment variable to point to the Oracle Admin 
Client installation directory.  
 
For example: 
1. Right-click My Computer and select Properties. 
2. Click Advanced system Settings > Environment Variables. 
3. In the System Variables panel, click New. 
4. Add the ORACLE_HOME variable to the New System Variable box, then click 
OK. For example: 
ORACLE_HOME=C:\app\Administrator\product\12.1.0\client_1 
5. Select the PATH variable in the System Variables panel, and click Edit. 
6. In the Edit System Variable box, add the path to ORACLE_HOME at the start 
of the PATH variable:  %ORACLE_HOME%\bin 
7. Restart the computer.  
8. Attempt to connect through VisiconX again to test connection succeeds. 

DE30309 Terminal 
Server/Remote 
Desktop 

Alarm Summary Blink Rate/Refresh Interval is overridden by the Terminal 
Server Throttle Configured in FixUserPreference.ini 
The Alarm Summary Blink Rate/Refresh Interval is overridden by the Terminal 
Server throttle configured in FixUserPreference.ini when running the Alarm 
Summary on a Terminal Server Client or via the general Remote Desktop 
connection. 

DE68669 Alarm Shelving Alarm Shelve Duration is Based on System Time 
Be aware that the durations are based off the system clock and not a timer. 

DE85273 Database Manager Alarm Area Mismatches for CTR, GAB, ITM, PAR, and P12 Loadable Blocks 
For the CTR, GAB, ITM, PAR, and P12 blocks, an upgrade to iFIX 6.0 does not fix 
issues with the Alarm Area 2 and Alarm Area 3 ordering. As a workaround, 
you need to export the database to a .CSV file, edit the Alarm Area 2 and 
Alarm Area 3 values, and then reimport the database back into iFIX 6.0 to fix 
the designated Alarm Areas. If the blocks are created using iFIX 6.0, there is 
no issue with alarm areas. 

DE86292 iFIX-SOA Service 
Provider 

Tags Created After Connection Established to the SOA Server Appear Missing 
When Browsing Tag Properties on SOA Node 
The workaround is to restart iFIX each time you add a new block type to the 
existing iFIX database. 

DE71528 WorkSpace Identifier Too Long Error for Long Tag Name on Script Behind Event 
Microsoft Visual Basic limits character identifiers to a maximum of 255 
characters. 

DE75993 Recipes Recipe Report Limits Tag Identifier to 100 Characters 
This is a known limitation in iFIX 6.0. 

DE81968 WorkSpace Quick Trend and Tag Control Panel Have Tag Length Limitations 
Tag Control Panel and Quick Trend Screens are limited to tag names of 234 
characters. 

DE82453 Upgrade Alarm Shelving and OPC UA Configuration Tool Security Features Not Added 
to iFIX Administrative User on Upgrade 
This is as designed for security purposes. After an upgrade, if you want to 
update your administrative groups to include the new security features, you 
will need to add them manually. 

DE79939 WorkSpace ToolTip Does Not Display Full 256 Character Tag Length in Command Script 
Wizard for Schedules 
Tooltip does not show full tag length in this case. This is a known software 
limitation. 
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Defect # Area Description 

DE82077 WorkSpace Tag Status Screens Have Tag Length Limitations 
There are limitations on screen that will not allow the full tag name to be 
displayed in Tag Status pictures. Even with the use of tooltips, you are 
restricted to 160 characters. 

DE69641 WorkSpace New Document Option Is Disabled in the System tree for Microsoft Word and 
Excel Files 
As a workaround, you can create the registry keys as described in the 
following articles. Restart the iFIX WorkSpace after doing making your 
changes.  
 
https://answers.microsoft.com/en-
us/msoffice/forum/msoffice_o365admin/why-docobject-registry-keys-with-
a-  
value-of-16-are/24cd9c98-46a9-4c10-8ca1-cb3933bd7817 
 
https://community.qlik.com/docs/DOC-14030 

DE80338 WorkSpace Tag Lookup Takes Longer Than Expected 
When browsing tags in the Expression Editor on a view node (iClient), it may 
take 50% longer to perform the initial tag lookup. 

DE66431 Enhanced Charts Long Tag Name Not Readable or Shrinks in Enhanced Charts 
After inserting a Line Chart or XY Chart, a long tag name is not readable or 
shrinks on the chart display. 

N/A Historian Integration iFIX Charts (with Historian data) Not Working on a System with Historian 7.0 
Mirroring when Primary Historian Server is Unavailable 
iFIX 6.0 currently does not support Historian 7.0 mirrored systems. 

DE17435 Dynamos Sometimes the Values Displayed on the HPTanksAnim and HPLinearGauges 
Dynamos Are Cut Off. 
Try saving the picture before switching to run mode or run the WorkSpace in 
Full Screen mode. Disabling Zoom to Fit may also display the values correctly. 

DE14743 Web HMI Export When Shape objects are aligned to each other with the Edge Width property 
set to 0, the objects display a white line within GE Web HMI browser client. 
When a picture is created in iFIX with Shape objects that are aligned to each 
other and the Edge Width property is set to 0, the objects in the exported 
picture display a white line when viewed within GE Web HMI. 
 
Workaround: If the Edge Width property is 0, set the Edge Style property to 
“EdgeStyleNone” in the object’s property window, or set Edge Style to “No 
Edge” via the object’s Right Mouse Menu option. Confirm that the objects look 
correct in iFIX Configure mode. Then, save and export the picture for Web 
HMI. 

DE29895 WorkSpace Some Anti-Aliased Lines that are Near Horizontal Appear Fuzzy 
With SmoothShapes (anti-aliasing) enabled, edge lines of some objects can 
appear fuzzy when they are at certain angles... such as with line objects when 
they are in a near-to-horizontal position. 
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Defect # Area Description 

DE26574 WorkSpace Some Text Objects Draw Lighter than Normal 
Text objects with a font size of 13 or smaller will draw without anti-aliasing 
regardless of the SmoothShapes setting in the picture. Size 13 fonts with the 
bold property set will draw with anti-aliasing. 
 
Text draws more clearly with SmoothShapes enabled at higher resolutions. 
Pictures that contain many text objects viewed at low resolution may display 
more clearly with the SmoothShapes property set to False. 
 
Changing the font style from Regular to Bold, or increasing the font size 
improves the readability of the text. 
 
Dynamo sets with text objects that use small fonts may need to be edited in 
pictures where SmoothShapes is enabled. Changing the font style from 
regular to bold or increasing the font size improves the appearance of the 
text within the Dynamo. 

DE25183 WorkSpace Anti-aliased Objects with Edge Style = 6 (inside frame) will See Color Outside 
the Object Frame 
Anti-aliased objects with edge style = 6 (inside frame) will see pixels for the 
background color or fill color outside the object's frame. There is currently no 
workaround. 

DE29588 WorkSpace LineChartPopUpHist.grf and LineChartPopUpReal.grf Pictures Display an Error 
when Switching from Configure to Run Mode 
These popup pictures are meant for the associated Dynamo objects 
(Chart_LineHist and Chart_LineRealTime). When the Chart_LineHist or 
Chart_LineRealTime Dynamo is dropped onto a picture, it displays the 
associated popup screen to set the plot styles and time definitions. These 
pictures are not meant to be edited directly. 

DE28601 My-T-Soft An Error Message Appears when Trying to Start My-T-Soft after Installing iFIX 
If you see a "server not licensed" error message from IMG, start the service 
manually.  From Start menu, select My-T-Soft > License Information to open 
the IMG application, and click the Start Service button.  You can also use the 
command line to start the service: Manage.exe START. After the service starts, 
try to run My-T-Soft again. 
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iFIX 6.0 Fixed Defects 
 
Case # Area Description 

SF 00438640 Database Dynamos Issues Setting the Time in the CHART_LINEHIST Dynamo 
In the CHART_LINEHIST Dynamo, when Fixed Time is set with zero hour, the 
Left Arrow button click may result in the Start Time going back by 1 day 
instead of 1 hour for some Time Zones. This issue is resolved in iFIX 6.0. 

SF 00538585 Enhanced Charts Network Transaction Deadlock with Enhanced Chart 
This issue is resolved in iFIX 6.0. 

CS0144096 VBA FIXTOOLS FixGetCurrentUser, FixGetUserInfo, and FixGetUserGroup Functions 
Do Not Work Correctly with User Accounts Using Windows Security 
This issue is resolved in iFIX 6.0. 

CS0079021 WorkSpace Windows Taskbar Not Visible 
This issue is resolved in iFIX 6.0. 

SF 00424837 WorkSpace Dynamo object from the  Chart_TableHist Dynamo Set Displays Invalid Time 
in Run Mode 
"When a picture with a Dynamo object from the  Chart_TableHist Dynamo set 
is opened in run mode, the Dynamo object with ""Sample"" historical mode 
displays invalid  time. This issue is resolved in iFIX 6.0." 

SF 00567138 Database Manager Database Manager Shutdown when Loading Column Layout 
This issue is resolved in iFIX 6.0. 

SF 00572201 Electronic 
Signatures 

Electronic Signature Comment Required and Event Messaging (Suspend 
mode) Unable to add to Display Columns 
Electronic Signature Comment Required and Event Messaging (Suspend 
mode) are unable to add to Display Columns in Database Manager due to 
missing entries in dbbfld.ini. This issue is resolved in iFIX 6.0. 

SF 00411359 Standard Charts Real-time Pen with Constant Line option Disappears on Standard Chart  After 
the First Historical Update or on Zoom/Undo Zoom event  
For a Standard Chart set with same time Refresh Rate and Historical Update 
Rate, the Real-time Pen with Constant Line option disappears after the first 
historical update or on Zoom/Undo Zoom event until the next refresh. This 
issue is resolved in iFIX 6.0. 

SF 00488090 WorkSpace Workspace Shut Down When Opening and Closing Pictures 
This issue is resolved in iFIX 6.0. 

CS0096704 Charts Historian Data is not Initially Fetched in Standard and Enhanced Charts when 
the Chart is in a Group 
This issue is resolved in iFIX 6.0. 

SF 00421264 WorkSpace When Picture Cache is Enabled, Enhanced Line Chart does not Follow Zoom 
to Fit when Picture is Closed and Re-opened in Run Mode 
This issue is resolved in iFIX 6.0. 

SF 00422833 WorkSpace Unable to Undo Move Actions when Drilling Down into a Group 
This issue is resolved in iFIX 6.0. 

SF 00351630 WorkSpace Chord Object Disappears when Picture is Upgraded to Enhanced Coordinates 
This issue is resolved in iFIX 6.0. 

SF 00440601 WorkSpace Line Chart Fails to Update Animated Property when Picture is Opened in Run 
Mode 
This issue is resolved in iFIX 6.0. 

CS0084058 WorkSpace Microsoft Forms 2.0 OLE Controls Are Not Allowing Polish Diacritical and 
Russian Cyrillic Characters with Keyboard 
This issue is resolved in iFIX 6.0. 

SF 00482596 Security 
Synchronizer 

Security Synchronizer Crashes on German iFIX System 
This issue is resolved in iFIX 6.0. 
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Case # Area Description 

SF 00506079 Enhanced Failover ScadaRoleMgr.log File is Not Created 
This issue is resolved in iFIX 6.0. 

CS 0002758 Alarm Summary Alarms Not Displayed When Using Dynamic Language Switching 
When using Dynamic language switching, after setting the filter to Ack = 
Unacknowledged, Alarms are not displayed in the Alarm Summary control 
.This issue is resolved in iFIX 6.0. 

CS 0004260 Alarm Summary Status Bar on the AlarmSummary OCX Control Blinks/Flashes  
This issue is resolved in iFIX 6.0. 

CS 0002332 Alarm Summary TopVisibleRow and BottonVisibleRow Properties  Do Not Update When Used 
in a Datalink  
This issue is resolved in iFIX 6.0. 

CS 0002379 Alarm Summary Grid Lines Do NotDisplay 
The The Alarm Summary control is not showing grid lines when alarms are 
displayed despite the option Show Grid Lines has been selected in its 
configuration. This issue is resolved in iFIX 6.0. 

SF 00481635 Alarm Summary Text is Gray When Reversing the Colors of the Alarm Summary Object  
This issue is resolved in iFIX 6.0. 

SF 00410388 WorkSpace WorkSpace Intermittently Shuts Down when ALT-Tabbing Between 
Applications 
This issue is resolved in iFIX 6.0. 

SF 00180063 Database Manager Alarm Area Values Mismatch in D16 Block 
This issue is resolved in iFIX 6.0. 

SF 00433920 VBA ReadValue Global Subroutine Sends Two Lookup Transactions, Resulting in 
Slower Turnaround Time 
This issue is resolved in iFIX 6.0. 

SF 00536409 WorkSpace Acknowledging a Page of Alarms and an Electronic Signature Causes a 
Shutdown of the WorkSpace 
This issue is resolved in iFIX 6.0. 

SF 00473749 Windows SecShellHelper Application Displays an Error Message when the Operating 
System is Configured to use Shell Launcher 
This issue is resolved in iFIX 6.0. 

SF 00461861 Enhanced Failover File Transfer Timeout for Redundant SCADAs Not User-configurable 
This issue is resolved in iFIX 6.0. 

SF 00556634 Startup Fix.exe Shut Down at Start When PROFICYENABLEFOCUSTRACKING.EXE Entry 
in the Fix.ini is Enabled 
This issue is resolved in iFIX 6.0. 

SF 00372935 WorkSpace Button Text Overlay Issues with Zoom to Fit 
This issue is resolved in iFIX 6.0. 

SF 00552830 Enhanced Charts Enhanced Chart has Striped Background 
This issue is resolved in iFIX 6.0. 

SF 00442433 Enhanced Failover Text Messages Not Sent to the Active Secondary SCADA Node when the 
Primary SCADA Node is Down 
This issue is resolved in iFIX 6.0. 

SF 00461671 WorkSpace Network Transaction Deadlock in FixComponent 
This issue is resolved in iFIX 6.0. 
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iFIX 6.0 System Requirements 

Software Requirements 

GE recommends using the latest service packs for Windows operating systems. The minimum iFIX 
software requirements include: 

• One of the following operating systems:  
• Microsoft® Windows® 10 (32-bit or 64-bit), Pro or Enterprise Edition.  
• Microsoft® Windows® 8.1 (32-bit or 64-bit), Professional or Enterprise Edition.  
• Microsoft® Windows® 7 (32-bit or 64-bit), Service Pack 1, Professional, Enterprise or 

Ultimate Edition.  
• Microsoft® Windows® Server 2012 R2.  
• Microsoft® Windows® Server 2016.  
• Microsoft® Windows® 7 Embedded Standard, Service Pack 1, for iFIX 6.0 Embedded 

licenses only. iFIX Embedded licenses will not run on Windows 10 IoT or other 
operating systems. 

TIPS: Since Microsoft Windows has continuous updates, you should run the Windows 
update feature to get the latest Windows software for use with iFIX. Some operating 
systems require Microsoft KB2999226 to be installed before you can install iFIX. For 
Windows 7, you must have SP1 installed before you can install KB2999226. For Windows 
Server 2012 R2, you must have KB2919442 and then KB2919355 installed before installing 
KB2999226. For Windows 8.1, you just need KB2999226. 

• Network interface software for TCP/IP network communication and certain I/O drivers.  
• If you are using third-party software along with iFIX, make sure that the third-party software is 

also supported for the operating system you are running iFIX on. For instance, if you are 
running iFIX on Microsoft Windows Server 2016, your third-party software must also be 
supported on Windows Server 2016. 

• An I/O driver for iFIX SCADA servers. GE supplies I/O drivers for many programmable controllers 
or you may purchase a driver separately.  

IMPORTANT: Be certain that before you purchase an I/O driver, that the driver is 
compatible with the hardware and operating system that you intend to run it on. For 
example, if the driver is not supported on a specific operating system, then you cannot use 
that driver with iFIX running on that operating system. For more information on iFIX 
supported drivers and their respective operating systems, refer to the GE Digital support 
web site at: http://ge-ip.force.com/communities/. 

• If using VisiconX and Historian, you must install the Historian OLE DB driver. 
• If using the Plant Applications Dynamos in iFIX pictures, Microsoft Office 2003, 2007, or 

2010(32-bit) is required. 
• One of the following relational database applications, if relational database software is used 

with iFIX: 
• Microsoft® SQL Server 2017 
• Microsoft® SQL Server 2016 
• Microsoft® SQL Server 2014 
• Oracle® 12c 
• Microsoft® Access 2000 (or higher). Microsoft Access is supported for local installs only 

 

http://ge-ip.force.com/communities/
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Hardware Requirements - iFIX without Enhanced Failover or Historian 

For iFIX computers, the recommended minimum hardware requirements are: 

• A 3.0 GHz Intel® Core™ i3 Processor or equivalent with 4GB of memory.  
NOTE: To use more than 4 GB of memory on a 32-bit platform you need to use Physical 
 Address  Extension (PAE). For more information on PAE please reference: 
https://msdn.microsoft.com/en-us/library/windows/desktop/aa366796(v%3dvs.85).aspx. 

• SpeedStep® technology is not supported and must not be enabled. 
• For time synchronization, the Windows Net Time and W32tm commands are both supported. 

However, if using the W32tm command, be sure to use the /nowait instruction when 
resynchronizing the clock. For example: W32tm /resync /nowait. The /nowait parameter 
instructs the operating system to make a stepping adjustment against the time server. 

NOTE: With virtual machines, the host and guest operating system need to synchronize 
against an external physical Network Time Protocol (NTP) Server. 

• The power save settings on your computer must be disabled. Do not use any power setting 
features that affect CPU clock speed. 

• A minimum of 10 GB of free hard drive space for iFIX pictures, databases, alarm files, and other 
data files. Even after allowing for an extra GB for iFIX, it is strongly recommended that many 
GBs of additional free space exist on the hard drive to avoid performance issues. 

Be aware that iFIX alarm and historical data files grow dynamically. If you plan to perform 
extensive alarm or data collection on a node, you may need more disk space on that particular 
node.  

• Other GE products, such as Plant Applications, Historian, and Real-Time Information Portal, 
impose additional requirements. Refer to the Important Product Information (IPI) topic in the 
product's electronic books for specific system requirements. Click the System Req. tab in that 
product's IPI for details. 

• 100 MBit or faster Full Duplex TCP/IP-compatible network interface adapter for iFIX network 
communication between SCADA and Client nodes.  

NOTE: iFIX no longer supports NetBIOS. 

NOTE: iFIX does not support IPv6. 

• One free direct-connect USB port. Some touch screens, pointing devices, and I/O drivers 
require a serial port. Additional ports for I/O hardware should be ordered with the computer. 

• SVGA or better color monitor with a 24-bit (16,777,216 colors) graphics card capable of at least 
1024x768 resolution. For Windows 7, the graphics cards should be Windows 7 (certified).  

• Two-button mouse or compatible pointing device (such as a touch screen) that can open a 
context menu.  

 

Hardware Requirements - iFIX with Enhanced Failover Enabled 

For iFIX computers with SCADA Enhanced Failover features enabled, the recommended minimum 
hardware requirements are (for both primary and secondary computers): 

IMPORTANT: The minimum requirements below assume that you are running only a SCADA server 
without additional applications, such as EDA applications. If you want to run more applications, 
you will need to increase your hardware support for better performance.  

• A 3.0 GHz Intel® Core™ i5 Processor or equivalent with 4GB of memory. For better 
performance, please consider using more memory. 

http://msdn.microsoft.com/en-us/library/windows/desktop/aa366796(v%3dvs.85).aspxs
http://msdn.microsoft.com/en-us/library/windows/desktop/aa366796(v%3dvs.85).aspxs
https://msdn.microsoft.com/en-us/library/windows/desktop/aa366796(v%3dvs.85).aspx
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NOTE: To use more than 4 GB of memory on a 32-bit platform you need to use Physical 
 Address  Extension (PAE). For more information on PAE please reference: 
http://msdn.microsoft.com/en-
us/library/windows/desktop/aa366796%28v=vs.85%29.aspx. 

• SpeedStep® technology is not supported and must not be enabled. 
• For time synchronization, the Windows Net Time and W32tm commands are both supported. 

However, if using the W32tm command, be sure to use the /nowait instruction when 
resynchronizing the clock. For example: W32tm /resync /nowait. The /nowait parameter 
instructs the operating system to make a stepping adjustment against the time server. 

NOTE: With virtual machines, the host and guest operating system need to synchronize 
against an external physical Network Time Protocol (NTP) Server. 

• The power save settings on your computers and dedicated network card (NIC) must be 
disabled. Do not use any power setting features that affect CPU clock speed. 

• One additional Gigabit-Ethernet card (or better) dedicated for SCADA-to-SCADA traffic (for a 
total of at least 2 network cards). The dedicated SCADA-to-SCADA network card should be 
excluded from the iFIX-to-iFIX network (not enabled for LAN redundancy), and used exclusively 
for Enhanced Failover synchronization. Both network cards must be of the same speed, and 
appear on the compatibility list for each card. It is strongly recommended that the cards be of 
the same make and model number, and use the same drivers.  

IMPORTANT: You must use a direct connection via a Cat6 crossover cable, without going 
through any switches, hubs, or routers. Due to limited bandwidth and latency, wireless 
networking technology should not be considered. 

• The wake-up upon receiving a socket or/and request feature must be disabled on the 
dedicated SCADA-to-SCADA network card.  

• Jumbo Frames technology must be used on the dedicated network for Enhanced Failover. 
Jumbo Frames technology allows for an Ethernet frame of 9000 MTU for the payload, 
compared to a frame of 1500 bytes without the Jumbo Frames.  

• A minimum of 10 GB of free hard drive space. Even after allowing for an extra GB for iFIX, it is 
strongly recommended that many GBs of additional free space exist on the hard drive to avoid 
performance issues. 
Be aware that iFIX alarm and historical data files grow dynamically. If you plan to perform 
extensive alarm or data collection on a node, you may need more disk space on that particular 
node.  

• Other GE products, such as Plant Applications, Historian, and Real-Time Information Portal, 
impose additional requirements. Refer to the Important Product Information (IPI) topic in the 
product's electronic books for specific system requirements. Click the System Req. tab in that 
product's IPI for details. 

• Primary and Secondary SCADA computers located physically next to each other, in the same 
location/room. 

• One free direct-connect USB port. Some touch screens, pointing devices, and I/O drivers 
require a serial port. Additional ports for I/O hardware should be ordered with the computer. 

• SVGA or better color monitor with a 24-bit (16,777,216 colors) graphics card capable of at least 
1024x768 resolution. For Windows 7, the graphics cards should be "Windows 7 (certified)".  

• Two-button mouse or compatible pointing device (such as a touch screen) that can open a 
context menu. 

 

https://msdn.microsoft.com/en-us/library/windows/desktop/aa366796(v%3dvs.85).aspx
https://msdn.microsoft.com/en-us/library/windows/desktop/aa366796(v%3dvs.85).aspx


 

45 

Wireless Devices and iFIX 

It is strongly recommended that you do not run SCADA nodes on wireless devices. Running an iFIX 
SCADA on a wireless device may impact performance, as most available wireless protocols fall below 
the recommended bandwidth requirements. 

Virtual Machine Support 

As part of our development testing and qualification, we make extensive use of virtualized 
environments.  iFIX does not target any specific hardware or virtualized platform.   

GE Digital will support the functional operation of the product that is running on a supported Operating 
System in a virtualized environment and will address any functional issues related to the software. 

GE Digital cannot guarantee performance of the software in the virtualized environment due to the 
wide range of parameters associated to the hardware, configuration, memory settings, 3rd party 
software, and the number of virtual sessions running on the same hardware, all of which can affect 
performance. GE Digital can only provide best possible support related to the performance of the 
software running on a VMWare based system or configuration of VMWare system. 

It is the responsibility of you, the customer, to ensure that the performance of the GE HMI/SCADA 
software and application are adequate to meet the needs of their runtime environment. GE does not 
support issues related to functionality that is not available as a result of running in a virtual machine. 
Examples include the functionality of card level drivers such as Genius, RMX, SA85 and functions 
requiring direct video access, or functionality of other software running in the same environment. It is 
your responsibility to check with the vendor of those applications for their ability to run in a virtualized 
environment. 

Each virtual machine instance that is using our software is required to have a valid license. The 
licensing in a virtualized environment will depend on the access to a hardware key or a license server 
depending on the selected license type. 

Remote Desktop (Terminal Server) Support 

When using Remote Desktop with iFIX, the following operating systems are supported for your server 
machine: Microsoft Windows Server 2012, Standard or Enterprise Edition, or Microsoft Windows Server 
2016, Standard Edition. 

The following Remote Desktop Client configurations were tested with iFIX: 

• Microsoft Windows 7: Remote Desktop Connection Version 6.1.7601 – Remote Desktop Protocol 
7.1 / Remote Desktop Connection Version 6.39600 – Remote Desktop Protocol 8.1 

• Microsoft Windows 8.1:  Remote Desktop Connection Version 6.39600 – Remote Desktop Protocol 
8.1 

• Microsoft Windows 10:  Remote Desktop Connection Version 10.0.17134 – Remote Desktop 
Protocol 10.5 

• Microsoft Windows Server 2012 R2:  Remote Desktop Connection Version 6.39600 – Remote 
Desktop Protocol 8.1 

• Microsoft Windows Server 2016:   Remote Desktop Connection Version 10.0.14393 – Remote 
Desktop Protocol 10.2 
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Compatibility with other GE Products 

Several GE products work with iFIX. The following is a general set of versions tested to work with the 
iFIX 6.0 product: 

Product Required Version 

Plant Applications 7.0 with SP4. 

Batch Execution 5.6. 

CIMPLICITY 10.0. 

Real-Time 
Information Portal 

3.5 with SP5 is currently NOT supported.  Please look to the 
https://digitalsupport.ge.com/ web site for an update after iFIX releases. 

Historian 7.0 SP6, 6.0. 

NOTE: If you are using VisiconX with Historian, you must install the 
Historian OLE DB driver. 

Change 
Management 
(PCM) 

9.5. 

Task List 2.6, 2.5 with SP4. 

Workflow 2.6, 2.5 with SP4. 

Web HMI 2.2, 2.1. 

WebSpace 5.0, 6.0. 

NOTE: When configured for WebSpace, none of the iFIX SCU’s on WebSpace 
Server should be configured to start iFIX as service, as this is a unsupported 
configuration. 

Win911 3.1.

DreamReports 4.83. 

IGS 7.63. 

NOTE: For information on product compatibility with critical Microsoft security patches, go to the GE 
Digital support web site:  

https://digitalsupport.ge.com/communities/en_US/Article/Information-on-Product-Compatibility-with-
Critical-Microsoft-Security-Patches   

You will need a customer login to access this page. 

https://digitalsupport.ge.com/
https://digitalsupport.ge.com/
https://digitalsupport.ge.com/
https://digitalsupport.ge.com/communities/en_US/Article/Information-on-Product-Compatibility-with-Critical-Microsoft-Security-Patches
https://digitalsupport.ge.com/communities/en_US/Article/Information-on-Product-Compatibility-with-Critical-Microsoft-Security-Patches
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